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INTRODUCTION

When developing or researching any electronic devices some electronics hobbyists frequently need to measure
signal parameters, preview inputs and outputs, and record and probably want to decode them. To solve this
problem when analyzing digital-to-analog circuits one need some instruments i.e: oscilloscope, spectrum
analyzer, recorder, and logic analyzer/pattern generator. Generally, each device requires a free interface
connector (usually LPT) and requires its own power source. In addition, functional measurement
instrumentation, made by known companies is too expensive both for radio amateurs and developers within
moderate-sized firms. At the same time, appearance of some new peripheral-rich microcontrollers with highspeed data communication channel support (USB1) which do not need an external power supply allows the
creation of a package combining all such functions at a give-away price. PoScope Basic is proved to be that very
affordable device.

Picture 1: PoScope Basic
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http://www.usb.org/developers/docs
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FEATURES

PoScope Basic provides the following operation modes:







2-channel oscilloscope (marker measurements, triggering (absolute, differential, external) and
adjustable pre-trigger, signal voltage and frequency measurement, filtering…).
2-channel spectrum analyzer (marker measurements, distorsion measurement, different window
functions, filtering…).
2-channel recorder (marker measurements, option to add 99 markers with comments, maximum,
minimum and average voltage measurement for each channel, waveform record within several tens of
hours.
16 (8)-channel logic analyzer (marker measurements, triggering (edge, level, mask) and adjustable
pre-trigger, external clocking (triggering), preset missing pulse, preset bit sequence/edge, decoding of
UART, SPI, I2C and 1-Wire interface).
5 channel square and PWM signal generator
8-channel pattern generator (tabular waveform formatting or direct timing chart plotting with mouse
on screen).

In addition, PoScope Basic allows user to:










Add comments to each measurement (to be recorded in the file with the measurement results)
Save all measurement results as a vector graphic or bitmap for subsequent importing into other
programs or in the data or text file for subsequent analysis.
Print all measurement results.
Copy all measurement results to a buffer.
Set events and sounds.
Calculate different digital filters and perform analog filtering.
Perform oscilloscope timing chart smoothing.
Display statistics for all channels of the logic analyzer and pattern generator.
Upgrade the device firmware via the USB bus allowing the device’s features to be added.

Picture 2: PoScope’s logic port
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TECHNICAL CHARACTERISTICS

Table 1: Technical characteristics
Oscilloscope, spectrum analyzer:
- number of channels
- sample rate
- memory depth
buffer reading:
pipe reading:
- input voltage
- ADC capacity

2
100 Hz … 200 kHz

- window functions

1126 sample/channel (1 channel), 563 sample/channel (2 channels)
64k sample/channel (1 or 2 channels)
-20 ... +20 V (hardware 2 sub-bands)
10 bits
absolute (for rising/falling edge),
differential (for difference between adjacent samples),
external (for rising/falling edge of TTL levels)
Hamming, Hanning, Blackman, Blackman-Harris

Recorder:
- sample rate
- maximum record time
- input voltage
- ADC capacity

0.01 Hz … 200 kHz
24 hours at Fs < 100 kS/s
-20 ... +20 V (hardware 2 sub-bands)
10 bits

- triggering

Logic analyzer:
- number of channels
- sample rate
- memory depth
buffer reading (Fs=4-8 MHz):
buffer reading (Fs=2-2.66 MHz):
buffer reading (Fs<=1 Hz):
buffer reading in concatenation mode:
pipe reading (Fs < 500kHz):
- input voltage
- triggering
- clocking
Pattern generator:
- number of channels
- sample rate
- memory depth
- output voltage
- maximum input/output current
Square signal and PWM generator
- number of channels
- frequency
- duty cycle
It works independent of other modes

16 (8 if pattern generator is on)
1 kHz … 8 MHz
128 bit/channel
1160 bit/channel
1544 bit/channel
1 Mbit/channel
4К to 256M bit/channel
0 ... +5 V (available surge voltage protection)
for edges, mask, miss pulses, external clocking
internal / external
8
1 kHz … 1 MHz
1544 bit/channel
"0" - 0 V, "1" - 3.3 V
10 mA
5
3,91 kHz – 1 Mhz
1- 99% f=7,8125 kHz
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INSTALLATION

Upon extracting the distribution file the driver setup and shortcut creation window opens.

Picture 3: Shortcut creation window
This window allows the drivers (usb_osc.inf, windrvr6.inf and windrvr6.sys files) to be automatically installed,
i.e. the files are copied to the corresponding system folders and registered in the Windows registry. When
installing the drivers it is only necessary to determine the operating system (whether Windows 98/ME or
NT4/2000/XP) and start the corresponding batch file from the Driver folder (install_win2k_XP.bat or
install_win98-ME.bat). If automatic driver installation fails then the drivers must be installed manually via
Device Manager. Please see the ReadMe.txt file for further driver installation information.
In addition to the driver installation this window allows for the creation of a program shortcut on the Desktop as
well as a shortcut group (program shortcut, help files and ReadMe.txt file) in the Windows "All Programs >
Start" menu.
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HARDWARE

As seen from picture 4, PoScope Basic has two analog inputs. For each of these an AC/DC switch is present.

Picture 4: PoScope Basic from top

The logic port pin-out is described in picture 5.
WARNING! Do no use pins marked with asterisk (*). You may destroy your unit.
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INTERFACE

Picture 5: Interface
This figure displays the main program window. There is a menu bar
below the window title. Four tabs
are
positioned beneath the menu bar to allow selecting of the operation mode. On the centre of the main window
there is a display
for the selected operation mode where all the measurement results are properly displayed.
Below the display panel there is a settings panel
for the selected operation mode. At the bottom of the work
window there is a status bar
where the current device status is displayed, e.g. information about waiting for
the measurement, as well as a brief program detail prompt, which appears when pointing to the relevant details
with a mouse.
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MENU BAR
8.1.

File menu

Picture 6: File menu
The File menu consists of the following items:








Open - opens the data file of the oscilloscope, spectrum analyzer, recorder or logic analyzer and the
corresponding comments that may be incorporated in the file. Upon opening the file you automatically go to
the corresponding tab (operation mode) and all the parameters are set in the status as before data storage.
Save data - allows saving of the measurement results, corresponding comments and current parameters of
the selected operation mode (current selected tab) into the data file.
Save as vector graphic - allows saving the measurement results of the selected operation mode as a vector
graphic in *.emf format (Enhanced Metafile).
Save as bitmap - allows saving the measurement results of the selected operation mode as a bitmap in *.bmp
format (Windows Bitmap).
Print preview - opens the preview window of the measurement results of the selected operation mode as they
would be printed.
Print - prints the measurement results of the selected operation mode.
Exit - exits from the application.

8.2.

Edit menu

Picture 7: Edit menu
The Edit menu consists of the following items:



Copy as vector graphic - allows copying the measurement results of the selected operation mode to the
Windows buffer as a vector graphic in *.emf format (Enhanced Metafile).
Copy as bitmap - allows copying the measurement results of the selected operation mode to the
Windows buffer as a bitmap in *.bmp format (Windows Bitmap).
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Clear - clears the measurement results of the selected operation mode.
Comments - opens the comment input window for the measurement results of the selected operation
mode.

Picture 8: Comments
Comment text is incorporated into the measurement results file. The maximum comment size is 64K for
Windows 98/ME, and for Windows 2000/XP it is limited by the maximum file size.

8.3.

Analog signals menu

Picture 9: Analog signals menu
The analog signals menu consists of the following items:






A/B channel smoothing – a submenu of this item allows the smoothing level of signal shape and noise
reduction to be set (only when operating in the oscilloscope mode).
Calc parameters – a submenu of this item allows the calculation moment of common signal parameters
(DC and AC voltage and frequency component) to be set. Parameters may be calculated before
processing (smoothing and filtering) when the real parameters of signal and processing will be
calculated. Parameter calculation upon processing may be useful if, for example, it is necessary to
determine the parameters of each dual-tone spectral component (DTMF) and for this purpose it is first
necessary to filter one component and measure its parameters and then to filter the next component and
measure its parameters also.
Processing – a submenu of this item allows different variants of the measurement result’s mathematical
processing (inverse, sum, difference) to be set.
Sounds - opens the event and sound settings window. This window may be useful when searching, for
example, a voltage of 3.3V to avoid constant jumping from the device on test to the monitor screen. In
such a case you can set a sound to inform you that the voltage in the selected channel is near 3.3V.
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Logic analyzer menu

Picture 10: Logic analyzer menu
The Logic analyzer menu consists of the following items:










Concatenation mode – concatenation mode of logic analyzer charts on/off control.
Keep the output levels – “keep generator outputs in last state” mode on/off control. If this mode is off
then the output level changes in accordance with the set timing chart only within measurement
(generation), i.e., upon pressing the "Run" button and until releasing it (when the button changes color
from red to green once again), upon measuring all outputs go to the third level. If the “keep the output
levels” mode is on then upon measuring the output level will correspond to the last timing chart value.
Outputs automatically go to the third level if “keep the output levels” mode is off or the generator
button is released. This mode is to eliminate the undesirable signal suppression (variation) if the
corresponding generator channels have accidentally not been disconnected from any elements of the
device on test.
Markers select - this menu item allows the generator data portion in the table to be selected, where the
portion limits are determined by the marker position, i.e. they are positioned between them.
Statistics - opens the statistics window.
Always on-top - enables or disables the statistics window position on top of the program. As the
statistics window occupies a considerably large part of the work window then if necessary it may be
hidden. However, sometimes, such as in concatenation mode when calculating the number of sync
pulses, it is convenient to position the statistics window on top to avoid constant opening.
UART, SPI, I2C, 1-Wire – opens the corresponding interface analysis and decoding windows.
Terminal - opens the terminal window - hardware support (input/output) of the analyzing interface.
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Service menu

Picture 11: Service menu
The Service menu consists of the following items:






Options - opens the operation mode settings window.
Color - sets the color of the work area, channels and scale.
Open options - opens the application options file.
Save options - saves the application options in the file.
Language - submenu of this item allows selecting the available interface languages.

8.6.

Upgrade menu

The Upgrade menu opens the device software (firmware) upgrade window as well as indicating the version and
release date of the current firmware.

Picture 12: Upgrade menu

8.7.

Help menu

The Help menu consists of the following items:



Help - opens the help window (file).
About program - opens the program
information window.
Picture 13: Help menu
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OSCILLOSCOPE

Picture 14: Oscilloscope window
This figure displays the main program window when operating in the oscilloscope mode. On the center of the
window there is a work screen where the oscilloscope displays are shown. The red oscilloscope display
corresponds to channel А and blue one corresponds to channel В. To the left of the work screen frame there is a
voltage scale for channel A (red font), and to the right of the frame there is a voltage scale for channel B (blue
font). Values of both voltage scales are always expressed in volts. Beneath the work screen there is a time base
(trace).
To the left and right of the work screen there are two cursors and
to allow shifting the zero of channel A
and channel B accordingly. It is an expedient to shift the zero if the waveforms of both channels overlap one
another so much complicating their analysis. To install one of the nine standard zero positions you need to rightclick on the corresponding cursor and then select one of the possible zero position values from the pop-up menu.
There are two markers
and
above the work screen frame that are used to perform the correct measurement
of time intervals and voltage amplitude values of each channel. The markers can be moved with the mouse by
left-clicking on the triangle and then moving the mouse to the left or the right while keeping the left mouse
button pressed. When moving the marker within the work screen the signal parameters below the marker will be
displayed on the panel .
To set the triggering level the two horizontal markers
and
are used. Marker
sets the voltage level
(amplitude) of channel A, which is used when triggering (absolute) is selected via channel A. Marker B similarly
sets the level used when triggering is selected via channel B. The triggering markers are moved in similar
manner to the markers
and , and when moved the level to be set is correctly displayed on the status bar.
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The Oscilloscope chart can be moved within the work screen using the standard scroll bar . Upon changing
the time base or zoom the previous oscilloscope display may not fit inside the work screen in full, and so the
slider will reduce in size within the scroll bar in proportion to the oscilloscope display length within the work
screen to the total oscilloscope display length ratio. There is a small button below the scroll bar that allows the
oscilloscope settings panel to be hidden so as to ensure greater area on the work screen.
The voltage scale range of channel A/B can be set on the panel / "Channel A/B (Volt/Screen)". The scale
range is set by the knob. Please note that PoScope Basic supports two input ranges: 0-2V and 2-20V by
hardware. This means that most reliable oscilloscope display when the amplitude is within ±2V it is prudent to
select the ±2Volt/division scale range or lower. As the error within the ±2Volt/division and lower will result in
4V/1024 = 0.0039V (10 bits A/D converter) whereas within the ±5Volt/division and higher the error will be 10
times larger 40V/1024 = 0.039 V. On/off buttons for the channels are positioned on the same panels. When
analyzing the device it is not required to analyze two analog signals at the same time, it is advised that one of the
channels is turned off so as to increase the maximum sampling frequency from 100 kHz to 200 kHz.
The "Period" panel
allows the sampling period (time base) within which the analog input digitization starts to
be set. For normal previewing of the oscilloscope display it is recommended that the sampling frequency is set
5-6 times higher than the maximum input frequency. In addition to select the time base on the "Period" panel
you can set the oscilloscope display zoom, i.e. stretch the oscilloscope display up to 4 times the time base for
more detailed analysis of any signal time parameters without any change in sampling period. In the upper right
corner of the "Period" panel there is a description of the reading mode (if enabled): buf - reading with
microcontroller internal buffer, or pipe - pipe reading in computer (sample buffer size increases several times but
requirements to the computer are getting tighter). Minimum/maximum period that allows determining the
reading mode is set in the Settings window. Double left-clicking on this reading mode description opens the
Settings window in a similar manner to the Service/Setup.
All the triggering control elements except for the markers are positioned on the "Triggering" panel . The On/
Off button allows triggering to be turned on and off. The A and B buttons select the channel and corresponding
marker for the signal that will be used as the triggering source. The Ext button indicates that the external source
connected to the logic analyzer’s B.5 channel will be the triggering source that functions as the input (external
triggering is available only when buffer reading). The edge select buttons determine which signal edge (rising or
falling) will show the absolute triggering, which signal step (rising or falling) will show the differential
triggering and which external sync pulse edge (rising edge or falling edge) will show the external triggering. The
two buttons positioned beneath the panel determine the triggering type: absolute or differential. A field
positioned near the differential triggering settings button determines the difference between the adjacent
waveform samples that if exceeded will cause the triggering condition to be met. It is necessary to note that
when setting triggering parameters that cannot be met, e.g. if given level is 5V and the maximum signal
amplitude does not exceed 2V, that the device will be continually waiting for a triggering condition to be met,
i.e. one of the start measurement buttons will be red. In this case it is not necessary to stop measurement when
pressing the Stop button as while measuring any triggering conditions they will be automatically transmitted to
the device.
On the "Signal parameters below markers" panel
the position of each marker within the time base and signal
amplitude of both channels below each marker are displayed. The time difference and signal amplitude of the
markers is also calculated and the difference result color is determined by the color of the marker corresponding
to the larger value.
On the "Common signal parameters" panel
the calculated values of DC and AC voltage components are
displayed and also, if possible, the frequency value for each channel.
The "Filtering" panel
ensures connection and calculation of digital filters for each channel. To turn on
filtering for the channel it is first necessary to calculate the filter. The filter settings window must be opened
while pressing the "…" button together ticking "on/off" of the selected channel.
To perform measurements it is necessary to press the Single or Cyclic button on the "Control" panel . The
Single button presets only one measurement (sample digitization and accumulation by microcontroller and then
their transmission to shell when operating via buffer). After that the newly read values are displayed on the work
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screen. The Cyclic button carries out similar actions except that upon completing the measurement a new
measurement starts automatically. Upon pressing one of the start buttons it changes its name to Stop and iturns
red. Pressing this button will lead to immediate device reset and cause it to wait for termination of measurement.
The Stop button may be the only means to stop measuring, e.g. when the triggering level is set so as to never
occur.

9.1.

Oscilloscope setup

Picture 15: Oscilloscope settings tab
This window can be opened by clicking “Tools > Options” from the menu bar and selecting the Oscilloscope
tab. The following elements are displayed in this tab:







Ts min buffer - list that allows the minimum sampling period below which will be a buffer reading to
be selected. In this case a minimum period equal to 10 μs (Fs =100 kHz) is set, and so for sampling
periods of 9 μs …5 μs (Fs =111 KHz …200 kHz) it will be a buffer reading and for sampling periods
of 10 ms…10 μs (Fs =100 Hz …100 kHz) it will be a pipe reading. Ts min buffer is determined by
experiment on the basis of several measurements. For example, it is first necessary to set Ts min buffer
= 5 μs, i.e. within any sampling period it will be pipe reading and perform the measurements for Тs=5
μs (Fs =200 kHz) as well and if there is not any signal distortion it means that your computer and
operating system can transfer data at maximum speed. In case of any distortion, it is necessary to
increase the sampling period, e.g. up to 6 μs (167 kHz) and perform the measurements again and so
on. Upon determining the sampling period with no distortion in the measurement results it is useful to
set it as min.
Pretrigger - allows presetting a number of samples to be stored before triggering. On the time base this
waveform portion is within the negative part, i.e. signal before triggering event - up to zero and signal
after triggering - after zero.
Buffer size 1024/512 bytes - forced reduction of buffer size from 1126 samples (1 channel)/563
samples (2 channels) samples up to 1024/512 samples. Why do we tick off this flag? FFT is used for
filtering and as is known, the number of samples for FFT has to be 2^n, i.e. if the filter is on for any
channel this will lead to automatic buffer depth reduction up to 1024/512 samples that may cause
some perplexity, e.g. why the signal for channel A (no filter) is longer than the signal for the channel
B (with filter). Unless necessary, do not uncheck this flag if the filter is not being used.
Memory depth - for pipe reading mode it is determined by the computer’s available memory and in the
oscilloscope mode this is artificially limited to 65535 samples for the channel. If the memory depth is
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too large it is not convenient to preview the periodic waveform (it is recommended to use the recorder
for analysis of non-periodic or very slow signals).
Disable averaging - this flag disables averaging to reduce the period (increase in frequency) of
sampling or performs averaging for several samples (arithmetic average).
Reference to the screen/reference to the signal - this flag sets the reference for the triggering markers.
If “reference to the signal” is selected the triggering marker will synchronously move within the screen
when changing time base or shifting zero while keeping the given position in Volts.
Filter auto on - enables the corresponding filter to be automatically turned on upon setting its
parameters.
Triggering auto on - enables triggering to be automatically turned on when pressing any button on the
“Triggering” panel.
Show the reading mode information (buffer/pipe) – When checked causes the reading mode
information to be displayed on the “Period” panel.
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10. SPECTRUM ANALYZER

Picture 16: Spectrum analyzer window
This figure displays the main program window when operating in spectrum analyzer mode. Most window
elements in this mode are similar to the corresponding elements when operating in the oscilloscope mode. The
exception being that the horizontal axis is set as the frequency axis; the time base is set as frequency/screen and
the voltage scale is negative amplitude-free.
New elements relating exceptionally to the spectrum analysis are shown. For example, on the panels "Channel
A/B (Volt/Screen)" there are additional "V / dB" and "0 dB = 0.775 V/0 dB = Umax" buttons
and
buttons. The first button determines the units that express the vertical scale: either Volts or dB. The second
button (which is active only if the first one is pressed) determines the voltage level that corresponds to 0 dB:
either 0.775 V or the maximum voltage value along the whole frequency axis for the set channel.
On the "Frequency" panel button
logarithmic.

has been added to determine whether the frequency axis is linear or

The “Triggering” panel has been replaced by the FFT window function settings panel . On this panel there is
a dropdown list containing some common window functions: Hamming, Hanning, Blackman, Blackman-Harris.
Panel
has also been added and is for the calculation of nonlinear distortion factor or harmonic distortion
factor (HDF). On this panel you can view the results of general calculations of HDF, HDF of harmonic thirds
and frequency of the first (main) harmonic, which can be forced in the field F1 or calculated automatically when
ticking the [+] Max flag.
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Spectrum analyzer setup

Picture 17: Spectrum analyzer settings tab
This window can be opened by clicking “Tools > Options” from the menu bar and selecting the Spectrum
analyzer tab. The following elements are displayed in this tab:








Fs max buffer - list that allows selecting the maximum sampling frequency that if more than will be a
buffer reading. In this case the maximum frequency is set to 100 kHz, and so for a sampling frequency
of 111 kHz …200 kHz it will be a buffer reading and for a sampling frequency of Fs =100 Hz …100
kHz it will be a pipe reading. The Fs max buffer is determined by experiment on the basis of several
measurements. For example it is first necessary to set Fs max buffer = 200 kHz, i.e. at any sampling
frequency it will be a pipe reading and perform the measurements for Fs=200 kHz as well. If there is
no signal distortion then it means that your computer and operating system can transfer data at the
maximum speed. If there is distortion then it is necessary to reduce the sampling frequency, e.g. up to
190 kHz and perform the measurements once again and so on. Upon determining the sampling
frequency without distortion in the measurement results it is useful to set it as maximum.
Memory depth - when pipe reading memory depth is determined by the computer’s available memory
and in the spectrum analyzer mode this is artificially limited to 65535 samples per channel.
Disable averaging - this flag disables averaging to increase the sampling frequency or performs
averaging for several samples (arithmetic average).
Total number of the harmonics - determines the number of harmonics used when calculating the
harmonic distortion factor.
Filter auto on - enables the corresponding filter to be automatically turned on upon setting its
parameters.
Show the reading mode information (buffer/pipe) - causes the reading mode information to be
displayed on the “Frequency” panel.
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11. RECORDER

Picture 18: Recorder window
This figure displays the main program window when operating in the recorder mode. Most window elements
when operating in this mode are similar to the corresponding elements when operating in the oscilloscope mode.
There are several differences because when operating in the recorder mode the waveform is constantly read in
real time from the microcontroller. As a consequence in this mode there are no “triggering”, “filtering” and
“common signal parameters” panels. Also, the time base format (hours: minutes: seconds: milliseconds) is
changed.
It is important to note that in the recorder mode you can perform neither single nor cyclic measurement.
Therefore to start recording the waveform it is necessary to press the Start button. The button will then change its
name to Stop and its color to red. To stop recording it is necessary to press the Stop button. While recording, the
options to change the voltage scale range, to turn channels on/off and to change time base will be disabled. This
is connected with the real time waveform record and any change would lead to significant CPU usage resulting
in a skip of the new data portion.
In the upper right corner of the "Period" panel
instead of information about the reading mode there is
information about immediate waveform plotting in the recording mode (if enabled): Dis - disable plotting, En enable plotting. The reason to disable or enable plotting within the measurements is that within a sampling
period such as 5 μs (200 kHz). Each second it will be necessary to plot 200,000 dots on the screen, which is
outside the capabilities of even advanced computers. At this plotting rate it will be an unclear obscure image on
the screen (the waveform would just be leaping). On the other hand however, within large sampling periods
(lower frequency) displaying the measurement results immediately in the recording mode enables you to analyze
the signal variation dynamics visually and stop recording under certain conditions. Furthermore, in the recorder
mode you can both expand (increase) and compress (decrease) the waveform with the corresponding buttons and
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change time base. This is useful if you need to view the general waveform pattern, e.g. at Тs=5 μs, 1 minute of
signal (60/5e-6 = 12 million dots) is recorded.
In order to analyze continuous signals more conveniently the option of waveform pattern marking is added. To
the right of the "Period" panel there is a table
to add/delete/move to markers
and change parameters. To
add (create a new marker) it is necessary to double left click the mouse on a free cell of the table, to select the
free cell of the table and press the Insert key or to right click on the free cell and select "Add marker" item in the
dropdown menu . After that, if enabled, two dialog windows appear in which to create comments and choose
the color of the marker. Then, in the center of the work screen the newly added (created) marker will appear.
This added marker can be moved along the screen in a similar manner to other markers. To delete the markers it
is necessary to select the non-empty cell of the table and press the Delete key or to right click on the non-empty
cell, or to right click on the marker to be deleted itself and in the dropdown menu that opens /
select the
"Delete marker" item. As the markers are referenced to the time base (waveform pattern) then when moving or
zooming the waveform it may be that the set marker will be out of the viewable area of the work screen. To
move to the set marker quickly you need to select the corresponding cell of the table (in the marker’s color) by
left clicking it. Marker parameters (color and comments) can be changed in the corresponding pop-up menu. It is
necessary to note that the position of markers and their parameters are saved in the file with the measurement
results, i.e. when opening the file all the markers will point to the corresponding waveform patterns.
On the "General signal parameters" panel
channel are displayed.

the maximum, minimum and average voltage values for each

On the control panel the elements
are added that allow the time after which the waveform recording will be
automatically stopped to be set. Auto stop is convenient to use if it is necessary to perform a long but fixed
waveform record. Furthermore, when recording within the sampling periods of 0.1 ms and lower (frequency
higher than 10 kHz) it is strongly recommended to preset the necessary length of waveform record as it enables
the program to allocate the required memory in advance prior to the recording process and avoid its dynamic
allotment as required immediately within the waveform record process. There is a bar with information about the
total time of waveform record below the auto stop time settings element.
It is important to note that the recorder mode is extremely particular about the computer memory size as, for
instance when recording for a sampling period of 5 μs (200 KHz) within 1 minute the measurement results will
total: 200 000 (samples/sec) * 60 (sec) * 2 (vertical and horizontal coordinate) * 8 (double size) = 187 MB, and
the file with measurement results will be 187 MB.
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Recorder setup

Picture 19: Recorder settings
This window can be opened by clicking “Tools > Options” from the menu bar and selecting the Recorder tab.
The following elements are displayed in this tab:






Тs min record - list that allows selection of the minimum sampling period, below which recording is
disabled. In this case the minimum period has been set to 10 μs (Fs =100 kHz) so sampling periods of
9 μs …5 μs (Fs =111 kHz …200 kHz) cannot be selected. Тs min record ican be determined by trial
on the basis of several measurements. For example, it is first necessary to set Тs min record = 5 μs, i.e.
enable recording within any sampling period and perform the measurements for Тs=5 μs (Fs =200
kHz) as well. If there is no signal distortion it means that your computer and operating system can
transfer data at the maximum speed. If there is distortion you need to increase the sampling period, e.g.
up to 6 μs (167 kHz) and perform the measurements once again and so on. Upon determining the
sampling period without distortion in the measurement results, it is advised to set this as aminimum.
In other words, this option is used to prevent the setting of sampling periods that you consider may be
within the range that will be affected by distortion.
Тs min show - list that allows selection of the minimum sampling period below which immediate
waveform plotting in record mode is disabled. The reason to disable or enable plotting within the
measurements is that within certain sampling periods, e.g. of 5 μs (200 kHz), each second 200,000
dots need to be plotted on the screen, which is beyond the capabilities of even advanced computers
and at this plotting rate would be an obscure picture on the screen (the waveform would be just
leaping). On the other hand however, within large sampling periods (lower frequency), displaying the
measurement results immediately in the recording mode enables you to analyze signal variation
dynamics visually and stop recording under certain conditions. In addition, it is necessary to note that
“Тs min show” is more or less dependent on the number of recorded samples. For instance, with an
Athlon XP 1700, 512MB you can record a waveform with “Тs min show” of 20 ms (50 kHz) but after
3-5 minutes of recording (about 10 million samples) the next waveform plotting increases dramatically
due to the requirement to calculate the additional diagram parameters.
Disable averaging (Тs<10 ms) - this flag disables averaging to decrease the sampling period (increased
frequency) or performs averaging for several samples (arithmetic average). This flag is active only for
periods less than 10 ms (frequency higher than 100 Hz). For longer sampling periods (lower
frequency), averaging will be turned on automatically. When operating within sampling periods close
to “Тs min show” and “Тs min record”, it is recommended that averaging is disabled. In cases where
the sampling period is much longer than “Тs min show”, it is recommended that averaging is enabled
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based on considerations that the microcontroller data are read for 409 samples (512/1.25 (10 bits)) at a
time before plotting starts, e.g. for the sampling period of 10 ms (100) plotting will be performed
every 409 * 0.01 = 4 seconds and if averaging is enabled and “Тs min show” is set, for instance to 1
ms (1 kHz, i.e. when artificially limiting the maximum increase of sampling frequency up to 1 KHz)
then plotting will be performed every 409 * 0.001 = 0.4 seconds for 409/10=50 samples, at which it
will be more convenient to view the waveform variation.
Scaling by Ts - enables the signal compression/stretch when changing the sampling period. This is
intended for when the mass signal compression is necessary when you need to view the general
waveform pattern.
Ask for color when new marker is added - if the flag is set, then upon adding (creating) a new marker
the color settings dialog window automatically opens.
Ask for comments when new marker is added - if the flag is set, then upon adding (creating) a new
marker the comments input dialog window automatically opens.
Fast waveform plotting - if the flag is set, then the measurement results plotting is performed with
faster simplified functions. For Windows 98/ME operating systems, the accuracy of results shown can
be reduced in some way.
Do not show intermediate (merging) points - if the flag is set, then points plotted with the same
coordinates in pixels on the screen are not displayed. Waveform plotting will be much faster if a large
waveform portion is shown within a mass compression, but if there is an sudden signal variation then
it will be shown incorrectly within mass compression.
Do not show the total record time during the recording - if the flag is set and the sampling period is
fixed at which display of the measurement results is disabled immediately within the waveform record,
then the total record time will not be shown during the recording. Additionally, if the autostop time is
not fixed, then the total record time has to be calculated by any external timer. It is recommended to
set this flag at the maximum frequency and in low-speed computers, as the very bar plotting with the
total time requires greater CPU resources than the next data processing.
Dynamic memory allocation (on demand) - if the flag is set and autostop is not set then the memory
for the waveform samples storage is allocated immediately in the waveform record mode for which
greater resources are required and the maximum sampling frequency for low-speed computers
decreases. If the flag is not set, then before starting the program tries to allocate all available memory
but with a maximum of 256MB for which the waveform record starts with delay. If you know or can
predict the exact waveform record interval, it is strongly recommended to set the autostop time as it
will enable the program to allocate the necessary memory (there is no extra memory allocation) before
the record process starts.
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12. LOGIC ANALYZER / PATTERN GENERATOR

Picture 20: Logic analyzer and pattern generator window
This figure displays the main program window when operating in the logic analyzer mode. Elements such as
markers, scroll bar and sampling frequency settings panel (time base) are similar to the corresponding elements
when operating in the oscilloscope mode. Therefore we will only describe elements particular to the logic
analyser mode in this section.
To the left of the work screen there is a panel containing the names of all 16 channels, which are functionally
divided into two buses. The first 8 channels are related to bus A
and the next eight channels are related to bus
B . Channels of bus A (further bus A) are always used as the 8-channel analyzer. Channels of bus B (further
bus B) can be used either in the mode of additional 8-channel logic analyzer or as an 8-channel pattern generator,
or disabled. The operation mode of bus B is set by the corresponding buttons on the control panel .
Furthermore, the color and name of each channel can be changed and for this you need to point to the name of
the selected channel with the mouse cursor and left click. This will cause the channel settings window to open.
To change the channel name you need to input the new name in the "Channel name" field. To change the
channel color you need to left click on the "Channel color" dropdown list and then select the required color. If
there is not a suitable color in the list then click on color "Custom…" and the standard color settings window
will open. To apply these changes you need to click the ОК button and to undo all changes inserted you need to
click the Undo button.
Beneath the "Channels" panel there are two buttons
and colors in the file.

that allow the opening and saving of all channel names
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Picture 21: Channel settings
In the bottom left corner of the main window a "Generator data" panel is active when bus B is used in the mode
of the 8-channel pattern generator. As the panel name suggests, it is designed for setting (creating) the generator
timing charts. In the left part of the panel there is a table
containing the generator data in binary and
hexadecimal formats. Data in the table can be changed in two ways: by immediately keying or by selecting the
required part in the table and pressing the relative buttons of timing chart generation . To immediately edit the
data you need to press the button positioned next to the upper right corner of the table or double left click on the
table. To select the data you need to press the button positioned next to the upper right corner of the table once
again or press the shortcut keys Ctrl+D. To select the data part in the table it is necessary to first select the range
start by left clicking on the selected cell and then while holding the left mouse button moving the mouse up and
down. If you need to select a large data portion then it is practical upon selecting the range start to move to the
range end by moving the slider and then left click on the last cell of the range while holding the Shift key. To
select all the cells you can press the shortcut keys Ctrl+A. The data portion in the table can be selected with the
markers, the positions of which on the work screen determine the limits of the portion to be selected. It is also
possible to generate a pulse in one of the generator channels, the length of which is equal to a pulse in any
analyzer channel. To do this it is necessary to first determine the analyzer pulse limits with the markers and then
select the data portion in the table, pressing Ctrl+M and then pressing the "Ch.=1" button. There is a line with
information about the limits of the current selected data portion below the generator data table.
There is also a row of buttons
on the generator data panel that allows you to clear the generator data, reading
the generator data from a file or saving the generator data into the file, shifting the selected data portion for
backspace character up and down, cutting or coping the selected portion in the buffer (other than Windows
buffer) as well as pasting the data from the buffer in the table from the selected cell.
Generator timing charts can be set both as table and plot immediately on the work screen with the mouse. To
plot the timing chart of one of the generator channels it is necessary to set the mouse cursor between the dashed
horizontal lines determining the limits of the selected channel and press the left or right mouse button and then
when holding this button to move the mouse in a certain direction (left or right). If the left mouse button is
pressed then the plotted timing chart portion will accept the logical one status and if the right mouse button is
pressed then logical zero.
The "Frequency" panel
allows the setting of the sampling frequency (time base). This panel is functionally
similar to other time base settings panels. The only difference is that there are several sub-modes of the logic
analyzer, which are automatically selected depending on the set time base:




4…8 MHz - buffer size is just 128 bytes, only bus А is functioning, triggering by mask is only for the
bus А (ignoring don't care conditions), triggering by edge is only for the channels of bus B (i.e. you
can analyze 8-bit bus and trigger with signals WR, RD, etc.), no pre-trigger, no missing pulse. This
sub-mode is for the analysis of moderate-speed 8-bit buses that enable triggering for the additional
channels.
2…2.67 MHz - buffer size is equal to 1160 bytes, only bus А is functioning, triggering by mask is
only for bus А (considering don't care condition), triggering by edge is only for the channels of bus B
(i.e. if required triggering by edge for one of the channels of bus A the bus B should be connected),
fixed pre-trigger buffer length equal to 8 bytes, no missing pulse detection. This sub-mode is for
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analysis of low-speed 8-bit buses twhich enable triggering for additional signals and a small pretrigger.
1 MHz and lower (when buffer reading) - buffer size is equal to 1544 bytes, all modes are available
(analyzer, analyzer + generator, analyzer + analyzer). All types of triggering are active and there is
possibility of missing pulse detection, adjustable pre-trigger buffer depth 8 to 120 bytes. External
clocking (triggering) option is also avaiable. This sub-mode is general purpose and you can analyze
both low frequency data buses and bit-sequence interfaces (only analyzing and acquiring data). The
pattern generator is active in this sub-mode as well.
500 KHz and lower (when pipe reading) - buffer size is equal to and limited by the computer memory.
It is not recommended to set the buffer size more than several Мbytes as it is extremely inconvenient
to analyze such a long signal stream. One channel will fill the memory with 16 (2*SizeOf(double))
times more than the buffer size, i.e. to show the whole bus it requires a memory capacity that equals
16*8 = 128 times, providing that the waveform value changes every sample capture. If there are
pauses or pulses longer than one sample period capture then they are coded with just 16 bytes
(2*SizeOf(double)). When pipe reading bus А only is active, all types of triggering are available,
adjustable pre-trigger buffer depth is 1 to 99% of the given buffer depth. An option of external
clocking (triggering) is also added. This sub-mode is mainly for analysis of an interface sequence.
When using the computer memory as a waveform buffer you can record very long waveform streams
for subsequent analysis.
There are elements
below the sampling frequency settings knob that allow the external clocking
(triggering) mode to be turned on. With these elements you can select the edge of the external clock
signal to perform the sample capture. The external clock signal frequency can be set both by knob or
by inputting the exact frequency value in the field Fs. The external clock signal frequency value
setting is only for the correct display of charts in the time base.

It makes sense to explain the point of external clocking application with an example:
The figure displays the following binary waveforms:




blue color – input (line 1, 3)
red color - received (shown) signal (line 2, 5)
green color - external clock signal (line 4)

Picture 22: Binary waveforms
In the first case the internal sampling frequency is used, e.g. 1 MHz where the point of waveform sample capture
is shown with the dashed lines every 1 μs. Input frequency is approximately equal to 250 kHz, i.e. 4 times less
than the sampling frequency which is good enough. As it is evident from the two upper charts the first pulse and
pause when a receiving signal completely correspond to the input. The next pulse will be almost 50% longer
because at the point of sample capture the input was at the peak logical level for just several fractions of μs
longer than for the first pulse. As it is evident from the figure as the input frequency is approximately equal to
250 kHz, consequently there is a minor pulse and pause time jitter and the resulting signal is sufficiently
distorted (it is necessary to consider this if input parameters are to be correctly measured).
In the second case the external clocking is used. As is evident from the figure the input level changes with the
rising edge of the clock signal and the falling edge of the clock signal is approximately at the midlevel of the
input pulse or pause. From this example it can be seen that it is advisable to set clocking to the falling edge. The
point of waveform sample capture is shown with the dotted lines, which concurs with the falling edge of the
clock signal. As is evident from the figure this signal completely corresponds to the input except for bias for a
half a period of the clock signal, which has no influence.
Based upon this information it may be concluded that given the external clock signal synchronous with the input
a much more reliable measurement can be made (generally it is a common practice for protocol sequence). So,
when internal clocking was used there were 16 sample captures and a minor signal distortion occured. When
external clocking was used there were only 8 sample captures and this signal completely corresponds to the
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input. The "Value" of each sample capture increases because the sample capture is performed within the
"correct" point in time to be determined by the external clock signal. Moreover, if we suppose that instead of 4
input pulses we will receive only 2 input pulses and 4 clocks then with internal clocking we will in any case
receive 16 sample captures, of which half is needless. At the same time when using external clocking we will
receive only 2 "correct" sample captures. For the external clocking functions the microcontroller hardware is
used with which the external clock signal can be fed only to the channels of bus B, i.e. when applying bus B as
8-channel generator the external clocking can not be used.
All the triggering controls (called trigger for digital signals) except for the markers are positioned on the
"Trigger" panel . The On/Off button allowing to turn triggering on and off. Below this are the triggering
operation option buttons: with rising or falling edge of the selected channel signal or triggering with mask. There
is a dropdown list below the triggering signal edge option buttons that is used to select the triggering source
channel by edge only. To the right of the mask triggering settings buttons there are two small bus select buttons,
to which the given mask will be applied at triggering. The mask is set in the field positioned below the mask
triggering settings button in binary format where the symbol 'x' or '-' means a “don't care” condition of the
corresponding channel. In the bottom half of the triggering panel there are the elements that allow the skipping
of a set number of pulses . Missing pulse detection will be active only if triggering is on. To start the missing
pulse detection it is necessary to press one of the buttons determining the pulse start. If no button is pressed the
missing pulse detection is failed. In the field "N pulses" upon meeting triggering condition the required number
of missing pulses is set and in the dropdown list positioned beneath the panel the channel is selected for which
calculating and missing the given pulses number will be performed. It is advised to use the missing pulse
detection mode if concatenation mode is off.
On the "Signal parameters below markers" panel
the position of each marker on the time base and status of
each bus below the marker are shown in a similar manner to when operating in the oscilloscope mode. The time
lag for the markers is also calculated.
Panel
is used to find the bit sequence/edge on one of the two buses. Before you start it is necessary to select
the bus/channel to find and set the bit sequence/edge in binary, hexadecimal or decimal format. To start finding
it is necessary to press one of the search buttons. If the set bit sequence/edge is found then marker 1 will be
automatically shifted to it. Otherwise a message window with information about no set bit sequence/edge to be
found will open.
On the control panel
there are buttons determining the operation mode of the bus B. The button with a G icon
selects pattern generator mode and the button with A icon selects the additional 8-channel logic analyzer mode.
If no buttons are pressed then bus B is switched off. On the control panel there is also a start single measurement
button. It is necessary to note that if bus B is used in pattern generator mode and triggering is on then the data
will be fed to the generator bus upon completing the triggering event but not immediately upon pressing the Run
button.

12.1.

Concatenation mode

Concatenation mode is used to increase the memory depth of memory capacity for one channel while in
microcontroller buffer reading mode. The hardware allows selecting only 128 to 1544 bits for each channel
when using only 8 channels as logic analyzer.

Picture 23: Concatenation mode
Performance of the logic analyzer in the concatenation mode can be demonstrated by the following example.
Assume there is a device with a triggering channel and a data transmission channel, and the data transmission
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starts when the triggering signal goes from a high to low level. It is necessary to analyze all transmitted data
considering the information length is larger than one capture. To read all the data from the analyzed device, you
need to do the following:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

11.

12.

13.
14.

To illustrate analysis, let us name channel A0 as SCK and channel A2 as MOSI (interface SPI).
Turn on triggering as to the falling edge for channel SCK.
Press the "Run" button and restart the analyzed device.
As the triggering condition is SCK going from a high to low level then the start of the timing charts is to
match the start of transmission by the device.
Open the statistics window by pressing Ctrl+T and determine a number of falling edges for the SCK
channel, i.e. 50.
Turn on skip pulses from falling edge and set the number of missing pulses to 48 for the SCK channel.
Turn on the concatenation mode by pressing Ctrl+G.
Press the Run button and restart the analyzed device.
th
As the triggering condition is held the start of the timing chart is to match the 48 triggering pulse.
Upon completing the measurements in the upper right corner of the work screen the button with an icon
of two concatenated sheets under which there are two buttons with left and right arrows will appear.
When moving the scroll bar slider right to the end of the main chart (solid lines) the chart to be pasted
(dotted lines) will appear (these are the results of the last measurement with the 48 missing triggering
pulses).
As there are 50 triggering pulses in the main chart but it was missed by 2, it is necessary to shift the
chart to be pasted by 2 SCK pulses. For this purpose it is necessary to press the left arrow button and
keep pressing it until the start of this chart is shifted by two SCK pulses, and the main chart matched the
chart to be pasted for the data channel under two "excessive" SCK pulses. So, the figure displays that
the marker 2 points at the end of the main chart and the marker 1 point at the start of the chart to be
pasted shows considerable shift and as is clear from the figure it is necessary to shift this chart left a
little bit more to match it with the main one.
If the read concatenation matches the main chart incorrectly then you can change a number of missing
pulses and repeat all the actions from item 8. After that the previous read concatenation will be changed
to the newly read one and the duplicate concatenation measurement will have no influence on the main
chart.
If the chart to be pasted matches the main one correctly you can press the Concatenate button and then
the chart to be pasted continues the main one.
If the transmitted data are incompletely read as before then you need to repeat the steps from item 5.

When using the concatenation mode it allows increasing the memory capacity for one channel up to 1 Mbit, i.e.
almost 1000 times for additional steps of end user.
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Logic analyzer / pattern generator setup

Picture 24: Logic analyzer / pattern generator setup

This window can be opened by clicking “Tools > Options” from the menu bar and selecting the Logic analyzer
tab. The following elements are displayed in this window:







Fs max buf - list that allows selecting of the sampling frequency. If the frequency is higher buffer
reading will be selected. In this case the maximum frequency equal to 300 kHz is set, i.e. for the
sampling frequency from 400 KHz and higher buffer reading is selected. For the sampling frequency
of 1…300 kHz pipe reading is selected. Fs max buf is determined by experiment on the basis of
several measurements. So, e.g. you can first set Fs max buf= 300 kHz and perform the measurements
for Fs=300 kHz and if there is not signal distortion it means that your computer and operating system
can transfer the data in real time at the preset sampling frequency Fs=300 kHz. If there is distortion
then it is necessary to reduce the sampling frequency, e.g. up to 250 kHz and perform the
measurements once again and etc. Upon determining the sampling frequency where there is no
distortion in the measurement results, it is advised to set it as maximum. Theoretically the hardware of
the PoScope can transfer data at speed of 1 МBytes/sec but practically it will use only 256 kBytes/sec,
as there are not adequate SiLabs drivers avaiable when operating in synchronous mode. If the buffer is
small then the sampling frequency can be increased up to 400 kHz, e.g. when reading only 4k data,
there will not be enough time for the FIFO (1024 bytes) to be full consequently there will be no
distortion.
Pretrigger - allows setting of a number of samples (bytes) to be stored before triggering. On the time
base this waveform portion is negative, i.e. signal prior to triggering event is up to zero and signal
upon triggering is after zero.
Buffer size - when in pipe reading mode it is determined by the available memory size in the computer
and in the logic analyzer mode it is artificially limited to 256M. It is not recommended to set the buffer
size more than several Мbytes as it is extremely inconvenient to analyze such long signal stream and
the memory is mostly used to show (plot) charts on the screen.
Ch. [7]…[0] - flags enable data plotting for the corresponding channel of bus А when pipe reading. As
the standard sequential interfaces have a number of channels less than 8 then the bus A is always 8-bit
but when plotting the charts of the sequential interface the computer capabilities can be at maximum
capacity because of data plotting in the unused channels.
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Channel for external clocking (bus B) - allows selecting one of 8 channels of bus B to an external
clock signal.
Bus A inverse (for new devices) - this flag is only required for new devices so as to reduce the circuit
plate size. The channels of bus А are in inverse order.
Auto activate the trigger (triggering) - enables triggering to be automatically made when any button on
the panel "Trigger" is pressed.
Skip same bytes during search - when this option is active it allows a group of consecutive identical
bytes to be skipped when searching. For example, if bus A contains the bytes AA' BB CC AA'' AA*
AA DD AA''' and you need to find sequence АА then on the first press of the search button the marker
will point to AA', on the second press the marker will point to AA'' and upon the third press again
point to AA''' (if skip is enabled) or AA* (if disabled).
Show the reading mode info (buf/pipe) - enables information about the reading mode to be shown on
the panel "Frequency".
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13. GENERATOR OF PWM AND SQUARE SIGNAL

Picture 25: Generator

Generator of PWM and Square signal works independent of all other modes. You can enable generator, connect
its signal to some circuit and perform measurements with oscilloscope or spectral analyzer. PWM generator has
fixed frequency of 7,8125 kHz. It is possible to change Duty cycle from 1 to 100%. Square signal generator have
fixed duty cycle of 50%. Frequency is variable in 8 steps from 3,91 kHz to 1 MHz..
Because of hardware limitation user settings differ from real value which is displayed.

Picture 26: How to find generator
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14. READING MODES
This section describes the reading modes for analog signals. For digital signals they are tlikewise.
In this software two data reading modes are active:



pipe reading
microcontroller buffer reading

When in pipe reading mode the measurement process consists of the following steps:
1.
2.
3.
4.
5.
6.

Setting the sampling frequency.
Starting the pipe mode.
Reading the packets of 409 samples (512/1.25 (10 bits)) from the microcontroller in real time.
When the computer reads the packet, the microcontroller writes the samples to its FIFO (1024 bytes) to
ensure measurement continuity.
Extracting the packets, calibration, triggering as required.
Stopping the pipe mode upon filling the preset buffer.

When in microcontroller buffer mode reading the measurement process consists of the following steps:
1.
2.
3.
4.
5.
6.

Setting the sampling frequency.
Reading 1126 10-bit samples (microcontroller buffer capacity is 1024(xdata) + 256 (EP2) + 128 (EP1)
= 1408 bytes/1.25 (10 bits) = 1126 samples) at the preset sampling frequency. There is a compressing in
the internal buffer, triggering as required.
Notifying the computer about samples obtained.
Transmitting the microcontroller buffer to the computer.
Extracting the buffer and calibrating the samples.
Displaying the measurement results.

It follows that when reading with the buffer it is impossible to read more than 1126 waveform samples in one
continuous measurement. It is necessary to set a frequency to enable normal viewing both to low and highfrequency signals. So, for example, if the sampling frequency is always 200 kHz then when analyzing a tone
with a frequency of 1 kHz (i.e. 200 samples for signal period) 1156/200 = 5 full signal periods would be
displayed what is sufficient. When analyzing a tone with a frequency of 50 Hz (i.e. 4000 samples for signal
period) then less than 1/3 of the period would be displayed which is unacceptable for any analysis.
The question arises why we use reading with the microcontroller buffer. The point is that not all computers are
equipped with USB1.1 and Windows 2000 or XP operating systems, which ensure general process priority and
processor resource allotment. As the data exchange process is continuous and run in real time then increased
requirements are imposed on the computer (especially on the USB bus controller) and the operating system. To
ensure maximum sampling frequency when pipe reading, the USB bus controller must manage to read 512 data
bytes (EP3) from MK End Point each millisecond. At this point, the operating system shall allocate the
necessary resources for the data reading process, i.e. generally keeps the process and pipe priority. If you have at
least a Celeron 600, 128M RAM and Windows 2000 or XP operating system then you should be able to run at
maximum frequency (as tested on 3 computers), as long as no other resource-intensive applications are operating
concurrently.
If connecting the device your computer gives an "Out of bandwidth" error message, then you cannot operate at
the maximum sampling frequency, partly because of the low-speed computer and partly because of the device
capabilities. In this case the microcontroller buffer reading mode can help you because in this mode the
maximum sampling frequency is independent of the features of your computer.
However, you can use the pipe reading even for low-speed computers by selecting the maximum sampling
frequency on experimentation basis. The the automatic buffer reading mode will be selected as, e.g. in Celeron
300, 64M. In Windows 98, the pipe reading mode runs at Fs <=30 kHz, in Celeron 600, 128M Windows 98 at Fs
<= 100 kHz but in Windows 2000 the pipe reading mode runs at the maximum frequency.
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It is also necessary to note that when concurrently measurnig two channels at the same time the sampling
frequency doubles as, for example, at Fs = 100 kHz the sampling frequency is actually Fs = 200 kHz.. If 2
channels are measured at the same time the sampling frequency setup is automatically disabled if higher than
100 KHz.
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15. INFORMATION ABOUT THE CONTROL KNOB
Using the control knob allows for the positioning of more discrete values on the same area as compared with the
use of buttons. Set value is always shown in the same point (center of the control knob), i.e. it is not necessary to
find what button is pressed and, moreover, the use of such a control knob is both intuitive aesthetically pleasing.
These control knobs were specially designed to be used with the PoScope Basic, which is why there are a
number of particularities to know when usefully operating these controls that can save your time and increase
work comfort.

Picture 27: Knob
Methods to change the knob`s position:
1.

2.
3.

Using the mouse - when left clicking on the knob (cursor takes the form of a hand) and moving the
mouse but not exactly over the knob. When moving the mouse the knob cursor will be positioned along
a line drawn from the center of the knob to the mouse cursor position, i.e. Simulating the effect of a
mechanical control knob. Upon clicking on the knob this element is within the input focus, i.e. can be
key- or mouse wheel operated even if the mouse cursor is not on the knob. It is useful to know that most
other usable elements are out of input focus. You can change the different triggering modes/levels and
adjust the sampling period or peak-to-peak voltage by the mouse wheel.
Using the mouse wheel.
Using the keys Left, Right, Up, Down, Home, End, Page Up, and Page Down.

It is also necessary to note that when the mouse cursor is over the knob the prompt showing the value to be
set/set can be seen on the status bar.
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16. FILTER SETTINGS

Picture 28: Filter settings
The figure displays the filter settings window. Diagram AFC
of the filter to be calculated occupies the major
portion of the window. The horizontal axis represents frequency and the vertical axis represents gain, with scales
of time and decibels respectively. The required AFC is constructed using the mouse. The AFC diagram consists
of the reference points and straight lines connecting these reference points, for which the gain value between the
reference points is calculated by linear approximation. AFC construction starts when adding new reference
points by clicking the line (if the mouse cursor is over the reference point or line the cursor takes the form of a
hand). Upon clicking the line, a new reference point appears, which can be moved both vertically and
horizontally (except for the end reference points) but not further than the adjacent reference points. To move the
reference point it is necessary to select it with the mouse cursor, which then takes the form of a hand. Then left
click and start moving the reference point in the desired direction while keeping the left mouse button pressed.
When moving the reference point the current coordinates will be shown on the status panel: gain and frequency
factors. To delete the reference point, select it with the mouse cursor and left click while holding the Ctrl key
pressed.
In the upper part of the filter settings window there is a tools panel. At the top of the tools panel there is a row of
buttons
that allow changes to be undone, reading of the filter parameters from a file and saving the filter
parameters to a file.
Button
determines the dimension of the vertical axis. If the button is pressed then the axis is in terms of
decibels otherwise the axis is in terms of time.
Input fields "Kmax" and "Кmin"

sets the limits of the vertical axis either in time or in decibels.

Button
determines the zoom of the vertical axis: linear or logarithmic. If the button is pressed then the
frequency axis is logarithmic otherwise it is linear.
The input field "Fmax"
Button

is the maximum value on the horizontal frequency axis.

determines the filter settings and closes the work window.
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17. SOUNDS

Picture 29: Sounds
The figure displays the event and sound settings window. Sounds are active only when operating in the
oscilloscope or spectrum analyzer mode. Sounds may be useful when searching the set waveform, e.g. searching
the circuit with voltage of 3.3 V.
Functionally, the window elements are divided into two groups - one group for each channel. Each group of
elements is divided into three subgroups, each one for one of the measured signal parameters (DC or AC
component of voltage and signal frequency). For each measured parameter three events are provided: input
higher than set threshold, input lower than set threshold and input signal almost equal to the set threshold. The
threshold is set in the field positioned to the left of the name of the corresponding parameter. The sounds are set
when clicking the relative dropdown list and selecting one of the standard sounds or pressing the relative button
with an open file icon and selecting the required sound file. To listen to the selected sound it is necessary to press
the corresponding button (positioned on the same bar with event name) with loudspeaker icon. All standard
sounds are played through the PC’s built in speaker, selected sound files are played when using the computer
sound card, if avaiable. To disable all sounds for the selected channel you need to press the Disable sounds
button on the corresponding panel.
It is also worthwile to note that when comparing the parameter with the set threshold there is a short delta, which
allows reproducing sound ignoring the strict parameter value equality with threshold but within the short interval
near threshold. For voltage the delta is determined as ±5% of the scale range of the measured channel, e.g. if for
the channel A ±10 Volt/Division is set and value Uconst = 3.3 V then a sound will be reproduced if the DC
voltage component for the channel A is within 2.8…3.8 V. For the frequency the delta is always DC and equal to
±20 Hz.
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18. STATISTICS

Picture 30: Statistics
The figure displays the statistics window when using both buses; i.e. when the bus B is active either in the
pattern generator mode or in the mode of additional logic analyzer. The statistics window contains the following
elements: to the left there are the names of all usable channels, number of rising (front) and falling (rear) edges
of the measured channel and then minimum/maximum/average length of signal pulse and pause, at which the
average length is calculated for the whole signal but as arithmetic average between minimum and maximum
length and average signal frequency. Change in any data of the logic analyzer or pattern generator immediately
leads to recalculation of all statistics. To view statistics on-line you can enable the statistics window always on
top. Also constantly clicking it to move it over the main window is avoided.
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19. UPGRADING FIRMWARE

Picture 31: Upgrading firmware
The figure displays the device firmware upgrade window. This window is necessary because software of
PoScope Basic consists of two programs: the shell the user works with and the program uploaded into the
microcontroller inside the PoScope instrument (firmware). The firmware performs the primary processing of the
measured signals and transmits them over the USB bus to the shell program running on the PC, which then
realizes the user-friendly information presentation on the PC screen.
The shell program can be easily updated. It is possible that the shell program contain some bug. Newer version
will become avaiable.
Sometimes it may be necessary to make changes or improvements that cannot simply be realized by just
changing the shell file, e.g. to add new function. This window can help you as it allows the downloading and
installation of the latest version of the microcontroller firmware.
To start upgrading you need to open the firmware file by pressing the “Open” button and then the “Upgrade”
button becomes active . Information about the firmware file size and its version will be displayed. When opening
the file and there are not any error messages, you can press the “Upgrade” button. Then the device firmware
upgrade starts automaticilly. A progress indicator will give an information about the upgrade status that is
positioned just higher than the status panel. Upon completing the upgrade the corresponding message window
will appear.

ATTENTION! In no circumstances do not try to upload any inappropriate file as upon completing
upload the microcontroller control will be transferred to the uploaded program, which in turn, shall
enable to transfer control to the loading program. If the uploaded program fails to transfer control
to the loading program, your device will become completely inoperable, as the working firmware
version cannot be uploaded any more. In such case contact customer support at: po.labs@gmail.com
or www.poscope.com
ATTENTION 2! When you upgrading from version 2.X to version 3.X, you should follow these steps:
1. Open software version 2.x on your computer. Upgrade your device to firmware version 3.x
2. Close software version 2.x and continue in software version 3.x
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20. ANALYSIS OF STANDARD INTERFACES
When testing digital devices you may want to analyze a data communication channel. At first glance this trivial
task such as to take the timing charts from the necessary communication channel lines, determine the interface
type and manually decode the timing charts, does not appear very complex. But upon making some attempts to
decode the timing chart you will obviously not want to perform this mundane procedure too often. To set about
decoding it is necessary at least to become familiar with the specifications of the analyzed interface and master
its timing diagram formats. It will take long time, especially when you do not have the interface description to
hand. Upon familiarizing with the interface you will know the most interesting thing that is decoding. Generally,
for most interfaces there are some signs of byte transmission starting and ending, except for SPI, when the data
is transmitted without any delay. That's why decoding starts with the searching of signs. Upon finding, e.g. the
start transmission sign, one starts decoding the data and a lot of questions arise about particularities of the
analyzed protocol that require examining the specification of the analyzed interface, comparing the timing with
their waveforms in the specification. This, probably simple routine, can eat much of your precious time and keep
you away from more important tasks.. We can testify from our own experience that a lot of time can be lost for
interpretation of timing and decoding os an I2C (used in the video capture board). It take us three and half hours
to manually decode 48 bytes. All this was done on paper of coure subject to any error. When decoding the same
interface with a program on PC (prototype model of the logic analyzer) the whole communication cycle of 1026
bytes was analyzed in 8 minutes but it took one and a half days to write the analysis program for I2C.
It does not mean that without any preliminary preparation one can decode the data of any interface by pressing a
couple of buttons for several minutes. In any case before analyzing the selected interface it is strictly
recommended to read its specification as no program can help you without comprehension of interface operation
principles.

20.1.

UART interface analysis

Picture 32: UART interface analysis window

Picture 33: Working waveform
The upper figure displays the UART interface window. Underlying you can see the work screen area containing
the timing charts for the receiving channel (RxD) and transmitting channel (TxD). Marker 1 is set to the start
bytes 0x0F and marker 2 is set to the following start byte 0xAA of the channels RxD.
The upper part of the UART window contains an image of a typical timing chart of one byte of UART interface.
Beneath it there is the main settings panel relevant to the analyzed interface. Before you start decoding it is
recommended to set the names of the interface channels on the panel “Channels” of the logic analyzer. If you set
the names to RxD and TxD they automatically appear in the fields of the receiving and transmitting channels.
As is known from the UART interface specification, the start bit that is always logical zero goes before the data
bit transmission, then the data bits are transmitted, the lower bits come first, followed by even, odd or no parity.
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The transmission sequence is ended with one or two stop bits (signal going to high level). If there is no data
communication then the logic level of the corresponding channel (TxD or RxD) will always be high. That's why
it is advised to turn on triggering as to the falling edge. Before you start measuring it may be a good practice to
turn off the analyzed device and then press the “Start” button and afterwards the device should be turned on. If
triggering is set correctly then start of timing charts has to concur with the start of communication. For the
normal timing charts decoding it is necessary that the sampling frequency is 3-4 times higher than
communication rate (frequency), in a rough way, the rate is inversely proportional to the minimum pulse length,
e.g. for the channel RxD.
Upon taking the timing diagrams it is necessary to determine the communication rate. To determine the
communication rate automatically you may press the button with calculator icon. Communication rate is
determined automatically only on the basis of the timing chart of the channel RxD and if possible, corrected on
the basis of the standard series of speeds. Upon determining the communication rate it may be a good practice to
set the values of other interface settings correctly, which cannot be determined automatically. The most common
settings of UART interface are set as default. Upon setting all the parameters it is desirable to set marker 1 to the
start bit of the channel RxD and marker 2 to the start bit of the channel TxD otherwise the first 1-3 bytes can be
lost or decoded incorrectly.
Upon completing all such procedures you can start decoding when pressing the “Decode” button. Decoding
results will be displayed in the table in binary and hexadecimal formats. When double clicking on the selected
cell with the decoding results marker 1 goes to the start of the corresponding byte.
Note that in addition to the timing charts, the UART decoding window also allows the generation of timing
charts based on interface settings and table data (column TxD) for the channel TxD, which has to be one of the
pattern generator channels.
It makes sense to use the flag Auto (table field autofill) only if signal generation is required.

20.2.

SPI interface analysis

Picture 34: SPI interface analysis window

Picture 35: SPI waweform
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The upper figure displays the SPI2 interface analysis window. Underlying you can see image containing the
timing charts for the clock channel (SCK), select slave channel (~SS), receiving channels (MISO) and
transmitting channels (MOSI). Marker 1 is set to start byte 0xAA and marker 2 is set to start of the following
byte 0x55 of the channel MOSI.
The upper part of the SPI window contains an image of a typical timing chart of one byte of SPI interface.
Beneath it there is the main settings of the analyzed interface. Before you start decoding it is recommended to set
the names of the interface channels on the panel "Channels" of the logic analyzer. If you set the names to SCK,
MISO and MOSI then they automatically appear in the fields of the clock channel, receiving channel and
transmitting channel.
As is known from the SPI interface specification, there are not any special signs to determine a start byte, if the
data is transmitted without pause and select slave signal is not used. The only way to determine a start byte is to
start measuring before communicating with "correct" triggering iof the SCK channel. According to the SPI
interface specification, the SCK channel level in the standby mode (if no communication is present) may be both
high or low. That's why to set "correct" triggering it is necessary to determine the SCK level in the standby
mode. To this effect it is necessary to perform the measurements several times before a long pulse/pause appears
in SCK channel, which length has to differ sufficiently from adjacent pulses/pause. If a long pulse is found then
SCK channel level in the standby mode is high, i.e. triggering must be on the falling edge if a long pause is
found then SCK channel level in the standby mode is low and triggering must be on the rising edge. Before you
start measuring it may be good practice to turn off the analyzed device and then press the “Run” button and turn
on the device. If triggering is set correctly then the start of timing charts has to concur with the start of
communication. For the normal timing diagrams decoding it is desirable that the sampling frequency is 3-4 times
higher than the triggering frequency.
Upon taking the timing charts all values must be set correctly as otherwise waveform decoding can not be
started. The most common settings of SPI interface are set as default. Upon setting all the parameters it is
necessary to set marker 1 to the start communication (byte).
Upon completing all such procedures you can start decoding by pressing the “Decode” button. Decoding results
will be displayed in the table in binary and hexadecimal formats. When double clicking on a selected cell within
the decoding results marker 1 goes to the start of the corresponding byte.
It is wortwhile to note that in addition to timing charts, the SPI decoding window also allows generation of
timing charts based on interface settings and table data (column MOSI) for the channels SCK and MOSI, which
are to be one of the pattern generator channels.
It makes sense to use the flag Auto (table field autofill) only if signal generation is required.

2
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I2C interface analysis

Picture 36: I2C interface window

Picture 37: I2C waveform
The upper figure displays the I2C3 interface analysis window. Beneath it is an image from the work screen area
containing the timing charts for the clock channels (SCL) and data channels (SDA). Marker 1 is set to start
signal and marker 2 is set to start data byte transmission 0xFF.
The upper part of the I2C window contains an image of a typical timing chart of I2C interface address and one
byte transmission. Beneath it there is the main settings panel relevant to the analyzed interface. Before you start
decoding it is recommended to set the names of the interface channels on the panel "Channels" of the logic
analyzer. If you set the names SCL and SDA then they automatically appear in the fields of clock channel and
data channel.
As is known from I2C interface specification, the data transmission session starts with the start signal
transmission (when SDA goes from high level to low level while SCL is in high level) then the address or data
bits are send, first the high-order bits followed by the acknowledge. The stop signal completes the data
transmission (when SDA goes from low to high while SCL is high l). If there is no data communication on the
bus then the logical level of SCL and SDA lines will be always high because of the pull-up resistors. That's why
it is advised to turn on triggering on the falling edge for the channel SDA. Before you start measuring it may be
a good practice to turn off the device to be analyzed and then press the “Start” button and then to turn on the
device. If triggering is set correctly then the start of timing charts will show start of communication. For the
normal timing charts decoding it is necessary desirable that the sampling frequency is at least four times higher
than the triggering frequency.
Upon taking the timing charts it is desirable to set marker 1 to the start signal otherwise the nearest start signal to
the right of marker 1 will be searched for. In this case one session may be lost. Upon completing all such
procedures you can start decoding by pressing the “Decode” button. Decoding results will be displayed in the
table in character format (start, stop, communication direction signal and confirmation signal) and in binary
format (address and data). When double clicking on the selected cell within the decoding results marker 1 goes
to the start of the corresponding I2C interface element.
It is worthwile to note that in addition to the timing charts decoding I2C window timing diagrams based on
interface settings and table data (columns, address, R/W, data) can be generated for the channels SCL and SDA,
which are to be one of the pattern generator channels.

3
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It makes sense to use the flag Auto (table field autofill) only if a signal generation is required. The button with
the microcircuit icon opens the terminal window - hardware support (input/output) of the analyzed interface.

20.4.

1-Wire interface analysis

Picture 38: 1 wire interface window

Picture 39: 1 wire waveform
The upper figure displays the 1-Wire 4 interface analysis window. Beneath this is an image from the work screen
area containing the timing chart of data channel (DQ), where the measurement was performed at Fs =200 KHz
but the figure displays the timing chart for Fs =50 KHz. Marker 1 is set to the start reset pulse and marker 2 is set
to the start bytes transmission 0xСС.
The upper part of the 1-Wire window contains an image of a typical 1-Wire interface timing chart. As in the
timing chart the red lines imply that the bus has moved to logical zero by the master, blue ones - by slave and
gray ones imply that the bus is moved to logical item by pull-up resistor. Beneath it there is the panel of the main
settings incident to the analyzed interface. Before you start decoding it is recommended to set the names of the
interface channels on the panel "Channels" of logic analyzer. If you set the name DQ, then it automatically
appears in the field of data channel.
As is known from the 1-Wire interface specification, the session starts when the master sets the reset signal (low
level for more than 480 μs) and then confirmation signal is set in 15-60 μs (low level for 15-60 μs) in the case of
only one slave on the bus. Upon receiving the confirmation signal the master transmits one or more bytes (highorder bits go first) and the slave responds to the master as required. As the session starts when the DQ line goes
from high to low then it is advisedto turn on triggering as to the falling edge. Before you start measuring it may
be prudent to turn off the device to be analyzed and then press the “Start” button and turn on the device. If
triggering is set correctly then the start of timing chart will show at the start of communication. For the normal
timing charts decoding it is desirable that the sampling frequency is at least 200 kHz.
Upon taking the timing charts it is desirable to set marker 1 to the reset signal otherwise the nearest reset signal
right to marker 1 will be searched for. In this case one session may be lost. For detailed decoding and description
of transmitted bytes you can select one of the standard devices supporting 1-Wire interface, of course if its
instruction set is in agreement with the instruction set of analyzed device. There is only one type of devices thermometers DS18x20/DS18x22 in the dropdown list that can be subsequently added with other devices.
Upon completing all such procedures you can start decoding when pressing the “Decode” button. Decoding
results will be displayed in the table in hexadecimal format (Code) except for start and confirmation signal and
in character format (Description). When double clicking on the selected cell within the decoding results marker 1
goes to the start of the corresponding element of the 1-Wire interface.
4
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21. TERMINAL

Picture 40: Terminal
The figure displays the I2C interface hardware support.
The Terminal dialog allows reading and writing bytes tono the I2C bus. All four I2C mode are supported:
1.
2.
3.
4.

Master Transmitter, i.e. we notify that we shall transmit the data.
Master Receiver, i.e. we notify that we shall receive the data.
Slave Receiver, i.e. we are notified that we have to receive the data.
Slave Transmitter, i.e. we are notified that we have to transmit the data.

It is also possible to set the number of receiving / transmitting bytes, Slave addresses and transfer speed in
Master mode.
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22. SYSTEM SETTINGS
This program operates on a PCs where Windows 2000/XP runs satisfactorily, i.e. at least Celeron 500 and 64MB
RAM, but in less powerfull computers it is likely that the program will operate incorrectly especially for
computers running Windows 98/ME. In this case it is obvious that upon pressing “Start” measurements button
that it will immediately show “Stop” and no measurement results are displayed. This is due to "slow" event
processing of the USB bus, i.e. the system hasn’t enough time to transmit all information within the fixed period.
To eliminate this it is necessary to open the file PoScope.ini, which has to be located on the hard drive where it
was copying during installation (by default in C:\Program Files\PoScope) and find the lines:
[system]
usb_wr_timeout=50 - write timeout, ms
usb_rd_timeout=50 - read timeout, ms
These two parameters set the time interval in ms (timeout) within which the system has time to transmit (wr) and
read (rd) data block from the device. Both timeouts are equal by default to 50 ms, in a PC with an Athlon XP
1700 processor and 512MB RAM running Windows XP transmitting is well within 50 ms, in a PC with Celeron
600 and 192MB RAM running Windows XP the timeout value can be increased up to 100 ms although it will
run within 50 ms. With a Celeron 600 and 192 MB RAM running Windows 98 the timeout values have to be at
least 400-500 ms for normal operation. Test was also conducted with a PC Pentium 200 and 32MB RAM
running Windows 98 upon which it was curiously shown that the program runs even on this computer but
timeouts were about 1000 ms.
Moreover, there are also two important system parameters in the usb_osc.ini:
usb_reset_timeout=50 - delay after reset, ms
wait_reset_trigger=300 - delay before reset of hang triggering, ms
Upon resetting the device it is necessary to take some interval, in order that Windows has time to configure the
device, i.e. performing the standard startup functions, allocate address, etc. The slower the computer, the longer
these steps will take. This means that the delay shall be longer as well, approximately equal to the
communication timeout. When increasing any timeout it is necessary to increase delay after reset as well.
The value of wait_reset_trigger determines time to reset the device if the triggering parameters are changed and
the device shows no response, i.e. it hung. We can explain this parameter using the following example: if we
turn on absolute triggering, set the level to 5 V, and the maximum signal level is 2 V, i.e. Meaning that the
triggering condition will be never met because this device will be constantly in standby mode and no changes are
shown on the screen. We change the triggering level up to 1 Volt, upon this change the program is waiting for
wait_reset_trigger ms, if there is no response from the device, as is expected in this case because it is waiting for
executing an impossible triggering condition, then the device is reset and measurements are completed. This
delay is necessary to enable the device to respond if triggering conditions are seldom executable, e.g. every 250
ms. If a previous triggering condition is executed all the same then the device will not be reset within
wait_reset_trigger upon changing the triggering condition and it means that measurement will not be reset and
the results will be displayed.
Therefore is the additional line in the section [system]:
show_exchange_error=1
This line was added because some problems occurred when operating the device with laptops as well some
related to old installed driver versions being detected. They are as follows: upon starting the program only one
tab of the logic analyzer was displayed because software determined it as a cut-off version due to the core driver
(Jungo WinDriver) and data was read from the device incorrectly. Because no error messages are displayed and
we have not faced these problems in any of 10 computers where the device was tested and all the devices from
the first lot were operated correctly as well then possibility of this error was not considered. This line was added
to determine why, i.e. which error occurred within communication. If this device runs incorrectly or generally is
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out of operation then it is kindly recommended to set the value of this parameter to 1 and send me the error codes
but if it runs satisfactorily then you can disable this function and set the value of the parameter to 0.
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23. SHORTCUT KEYS
Table 2: Shortcut keys
Shortcut keys

Description

Ctrl+O

Opens a with oscilloscope data, spectrum analyzer data, recorder or logic analyzer data.

Ctrl+S

Saves the measurement results and current parameters of selected operation mode (current
selected tab) into a file.

Shift+Ctrl+S

Saves the measurement results and current parameters of selected operation mode (current
selected tab) into a file.

Ctrl+Alt+S

Saves the measurement results of the selected operation mode as bitmap in *.bmp format
(Windows Bitmap).

Shift+Ctrl+P

Opens the measurement results preview window.

Ctrl+P

Prints the measurement results of the selected operation mode.

Ctrl+Q

Closes program.

Shift+Ctrl+C

Copies the measurement results of the selected operation mode as vector graphic in *.emf
format (Enhanced Metafile) to the Windows buffer.

Shift+Ctrl+X

Copies the measurement results of the selected operation mode as bitmap in *.bmp format
(Windows Bitmap) to the Windows buffer.

Ctrl+N

Clears the measurement results of the selected operation mode.

Ctrl+R

Opens the comments input window.

Ctrl+Z

Opens the event and sound settings window.

Ctrl+G

On/Off concatenation mode of logic analyzer charts.

Ctrl+K

On/Off keep the generator output levels mode.

Ctrl+M

Selects the generator data portion in the table.

Ctrl+T

Opens the statistics window.

Ctrl+A

Selects all data table of logic analyzer´s table.

Ctrl+D

Goes from direct logic analyzer data edit mode to select mode.

Shift+Ctrl+D

Opens the generator setings window

space

Start / stop measurements
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24. HARDWARE ISSUE
There are not known hardware issues since Software and Firmware version 3.1.
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25. ECOLOGY
Protect our Earth
All PoLabs products are designed with the concept of energy savings in mind. Compared with
clasic oscilloscopes, PoLabs products consume relatively far less power than their counterparts. It
not only saves your money, but also saves The Earth.
All PoLabs products are produced with ROHS compliant parts and packed with recyclable or recycled packing
materials. PoLabs recognizes its responsibility as a global citizen and is continually working to reduce the
environmental impact of the products we create.
PoLabs products are produced under ROHS directive: http://europa.eu.int/eurlex/pri/en/oj/dat/2003/l_037/l_03720030213en00190023.pdf
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26. LICENSE AGREEMENT
The licensee agrees that access to this software and hardware is only allowed to persons who have been informed
of these conditions and agree to them.
Usage
The software in this release is for use only with PoLabs PoScope Basic.
Copyright
PoLabs claims the copyright of, and retain the rights to, all materials (hardware, software, documents, labels etc.)
contained in this release. You may copy and distribute the entire release in its original state, but must not copy
individual items within the release other than for backup purposes. You must provide a reference to PoLabs and
its website (http://www.poscope.com/) in case of distribution.
Liability
PoLabs and its agents shall not be liable for any loss, damage or injury, whatsoever caused, related to the use of
PoLabs equipment or software, unless excluded by statute.
Mission-critical applications
This software is intended for use on a computer that may be running other software products. For this reason,
one of the conditions of the license is that it excludes usage in mission-critical applications, for example life
support systems.
Viruses
This software was continuously monitored for viruses during production, but you are responsible for viruschecking the software once it is installed.
Support
If you are dissatisfied with the performance of this software, please contact our technical support staff, who will
try to fix the problem within a reasonable time scale.
Upgrades
We provide software and firmware upgrades, free of charge, from our web site. We reserve the right to charge
for updates or replacements sent out on physical media.
Returns Policy:
If there are any problems with your shipment please notify us immediately. Our goal is to have you as a satisfied
customer.
We reserve the right to ask you the customer to pay for all outward shipping fees and the return shipping fees.
We do not provide refunds for a PoScope Basic units that are damaged because of wrong firmware uploads (not
downloaded from PoLabs website or provided on the CD supplied with the PoScope Basic).
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Manufacturer’s warranty
We provide a manufacturer’s warranty for the device of 6 (six) months. If the PoScope Basic stops working you
may contact us (po.labs@gmail.com) to get the tech support request ID and send the device (you have to pay for
shipping and handling) to us. The device may not have any external damage!
We repair your PoScope Basic by replacing or repair the internal PCB (and leaving your box) and send it back to
you (we will pay for the shipping and handling). Please do not send PoScope Basic if it has any box damages.
We shall not replace it in these cases or if the device has been damaged as the result of wrong firmware upgrade
(not downloaded from PoLabs website or provided on the CD supplied with the PoScope Basic).
In case of support or repairs, please contact PoLabs: po.labs@gmail.com. Always write down serial number of
your PoScope as a reference.
Please send only PoScope Basic without the cables, probes or Setup CD.
Safety warning
The PoScope Basic ground is connected directly to the ground of your computer through the provided
interconecting USB cable. As with most oscilloscopes and data loggers, this is done in order to minimize
interference. You should take care not to connect the ground (screw terminal, outer shell of BNC or exposed
metalwork) of the PoScope Basic to anything that may be at some voltage other than ground. This could cause
damage to the unit, to your computer or lead to injury to yourself and others. If in doubt, use a meter to check
that there is no significant AC or DC voltage.
For computers that do not have an earth connection (for example laptops), it must be assumed that PoScope
Basic is not protected by an earth (in the same way a battery multimeter is not protected by an earth).
The maximum input voltage range of any input is -20 to +20V. Any voltage in excess of ±30V may cause
permanent damage to the oscilloscope or your computer..
The unit contains no user serviceable parts: repair or calibration of the unit requires specialized test equipment
and must be performed by PoLabs, or their authorized distributors.
Measurement category
PoScope basic is rated for use in measurement category I (EN61010 CAT I), which covers measurements on
circuits not connected to the mains. You must not use your PoScope basic to make measurements on any circuit
directly connected to the mains, unless you use a purpose built isolating probe rated for the appropriate voltage
and measurements category.
Limitation of liability
7.

YOU EXPRESSLY UNDERSTAND AND AGREE THAT NEITHER ELECTRONICS INFOLINE
NOR ANY OF ITS PARENTS, SUBSIDIARIES, AFFILIATES, SERVICE PROVIDERS,
LICENSORS, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS OR REPRESENTATIVES
SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INDICENTAL,
CONSEQUENTIAL OR EXEMPLARY DAMAGES INCLUDING BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF PROFITS, GOODWILL, USE, DATA OR OTHER INTANGIBLE LOSS
(EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES),
RESULTING FROM OR ARISING OUT OF (I) THE USE OF OR THE INABILITY TO USE THE
SERVICE, (II) THE COST TO OBTAIN SUBSTITUTE GOODS AND/OR SERVICES RESULTING
FROM ANY TRANSACTION ENTERED INTO ON THROUGH THE SERVICE, (III)
UNAUTHORIZED ACCESS TO OR ALTERATION OF YOUR DATA TRANSMISSIONS, (IV)
STATEMENTS OR CONDUCT OF ANY THIRD PARTY ON THE SERVICE, OR (V) ANY
OTHER MATTER RELATING TO THE SERVICE.
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HARDWARE PRODUCTS ARE SOLD AS STAND ALONE SYSTEM. WE MAKE NO
WARRANTY, REPRESENTATION, RESPONSIBILITY OR GUARANTEE REGARDING THE
SUITABILITY OF THIS PRODUCT FOR ANY PARTICULAR PURPOSE, NOR DOES WE
ASSUME ANY LIABILITY ARISING OUT OF THE APPLICATION OR ILLEGAL USE OF THE
PRODUCT, AND SPECIFICALLY DISCLAIMS ANY AND ALL LIABILITY, INCLUDING
WITHOUT LIMITATION CONSEQUENTIAL OR INCIDENTAL DAMAGES. THESE ITEMS ARE
NOT DESIGNED, INTENDED, OR AUTHORIZED FOR USE AS COMPONENTS IN SYSTEMS
INTENDED TO SUPPORT OR SUSTAIN LIFE, OR FOR ANY OTHER APPLICATION IN WHICH
THE FAILURE OF THE PRODUCT COULD CREATE A SITUATION WHERE PERSONAL
INJURY OR DEATH MAY OCCUR. SHOULD BUYER PURCHASE OR USE THESE PRODUCTS
FOR ANY SUCH UNINTENDED OR UNAUTHORIZED APPLICATION, BUYER SHALL
INDEMNIFY AND HOLD RCL AND ITS OFFICERS, EMPLOYEES, SUBSIDIARIES, DEALERS,
AFFILIATES, AND DISTRIBUTORS HARMLESS AGAINST ALL CLAIMS, COSTS, DAMAGES,
AND EXPENSES, AND REASONABLE ATTORNEY FEES ARISING OUT OF, DIRECTLY OR
INDIRECTLY, ANY CLAIM OF PERSONAL INJURY OR DEATH ASSOCIATED WITH SUCH
UNINTENDED OR UNAUTHORIZED USE, EVEN IF SUCH CLAIM ALLEGES THAT RCL WAS
NEGLIGENT REGARDING THE DESIGN OR MANUFACTURE OF THE PRODUCT. PLEASE
CHECK WITH LOCAL RULES & REGULATIONS IN YOUR COUNTRY BEFORE USE OF THE
PRODUCT.
MEMBER ACKNOWLEDGES THAT MEMBER HAS READ THIS AGREEMENT AND AGREES
TO ALL ITS TERMS AND CONDITIONS. MEMBER UNDERSTANDS THAT ELECTRONICS
INFOLINE MAY AT ANY TIME (DIRECTLY OR INDIRECTLY) SOLICIT CUSTOMER
REFERRALS ON TERMS THAT MAY DIFFER FROM THOSE CONTAINED IN THIS
AGREEMENT OR OPERATE WEB SITES THAT ARE SIMILAR TO OR COMPETE WITH
MEMBER'S WEB SITE. MEMBER HAS INDEPENDENTLY EVALUATED THE DESIRABILITY
OF PARTICIPATING IN THE MEMBER PROGRAM AND IS NOT RELYING ON ANY
REPRESENTATION, GUARANTEE, OR STATEMENT OTHER THAN AS SET FORTH IN THIS
AGREEMENT.

Under no circumstances shall we, nor our staff, agents or suppliers, be liable for any damages, including without
limitation, direct, indirect, incidental, special, punitive, consequential, or other damages (including without
limitation lost profits, lost revenues, or similar economic loss), whether in contract, tort, or otherwise, arising out
of the use or inability to use the materials available in this site or any linked site, even if we are advised of the
possibility thereof, nor for any claim by a third party.
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27. ABOUT THE COMPANY
PoLabs owns the intellectual property and exclusive rights on the PoScope Basic worldwide, except former
USSR countries.
PoScope Basic is made, calibrated and tested in Slovenia.
PoLabs provides technical support, customer service and manufacturer’s warranty of the PoScope Basic
worldwide except former USSR countries.

27.1.

Contact

If you have any questions feel free to ask by e-mail: po.labs@gmail.com or visit: www.poscope.com
Copyright © 2004-2008 – PoLabs
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